Hodges University Style Guide

Based on the Sixth Edition of the *Publication Manual of the American Psychological Association*

Susan Smith
Acknowledgements

I want to thank those who worked so diligently on this manual in the past, especially Dr. Elsa Rogers, Carolynn Volz for her ever present advice and assistance, Jan Edwards for her careful editing and the rest of the library staff for their comments and feedback.
## Table of Contents

Acknowledgements .................................................................................................................. 2

Table of Contents ...................................................................................................................... 3

What is Meant by Writing Style or Style Guide? ..................................................................... 6

   Benefits of Following Hodges Style Guide ......................................................................... 6

Formatting Manuscripts ............................................................................................................. 7

   Parts of a Paper ..................................................................................................................... 7

      Creating a title page ......................................................................................................... 10

      Sample title page ........................................................................................................... 13

      Creating a table of contents .......................................................................................... 14

      Headings ....................................................................................................................... 15

Documentation .......................................................................................................................... 16

   Using Hodges Style ............................................................................................................. 16

   In-text Citations .................................................................................................................. 16

      Common types of in-text citations ............................................................................... 17

      More examples of in-text citations ............................................................................... 19

   Reference List ..................................................................................................................... 22

   Print Sources: Books .......................................................................................................... 22

   Book Examples ................................................................................................................... 23

      With one author .............................................................................................................. 23

      With multiple authors ................................................................................................... 23

      With no listed author or editor ...................................................................................... 23

      With a corporate author ............................................................................................... 23
Edited book without an author ................................................................. 23
Edited book with an author ................................................................. 24
Multivolume work ................................................................................... 24
Part of a book: chapter, essay article, foreword, preface, afterword in a book ....... 24
Government report .................................................................................. 24
Print Sources: Articles ............................................................................. 24
Article Examples....................................................................................... 25
  Article in a scholarly journal, with DOI ..................................................... 25
  Article in a scholarly journal, without DOI ............................................... 25
  Magazine article .................................................................................... 25
  Newspaper article .................................................................................. 26
  Letter to the editor ................................................................................ 26
Other Sources Examples .......................................................................... 26
  Personal letter or other forms of personal communication ....................... 26
Audiovisual Source Examples ................................................................... 26
  Motion picture ....................................................................................... 27
  Television broadcast ............................................................................... 27
  Television series .................................................................................. 27
  Film ........................................................................................................ 27
  Music recording ..................................................................................... 27
  Music recording example ....................................................................... 27
  Software ................................................................................................ 28
Electronic Sources: Sources Accessed Online .......................................... 28
Hodges University Style Guide

**What is Meant by Writing Style or Style Guide?**

The goal of effective writing is communication. To be an effective writer, attention must be paid, not only to what is being said, or the content, but also to how it is being said. This guide will focus on proper citing of sources, references, formatting and more. Having a good and proper writing style gives credibility to what is written, and in the case of writing class assignments, it illustrates that the writer is able to communicate clearly and in an acceptable manner.

Various style guides are used for different disciplines and purposes. Hodges University requires students to use a guide patterned on the sixth edition of the *Publication Manual of the American Psychological Association* (APA). The APA manual or style guide sets forth principles for scientific communication in fields such as the social sciences, business, criminology, economics, and nursing.

**Benefits of Following Hodges Style Guide**

Following the Hodges Style Guide will help students develop writing skills that demonstrate credibility by avoiding plagiarism and academic dishonesty. Following these guidelines also improves chances of earning better grades, saves time, and builds an important set of skills for the future.

Following the guide will help students:

- Develop writing skills for courses and all writing.
- Lessen formatting problems.
- Increase credibility.
- Avoid plagiarism and academic dishonesty.
Formatting Manuscripts

This format is required for all APA documents.

- One inch margins on top, bottom, and sides of all pages.
- Times New Roman 12-point font for all text.
  - For charts and figures, it is acceptable to use a sans serif font such as Arial for better visual presentation
- Double space entire paper.
  - No extra lines after titles, headings, between sections, after reference list entries, etc. Hit enter once at the end of a paragraph.
- Indent first line of paragraphs one half inch (5 to 7 spaces).

Parts of a Paper

These appear in a paper in the order listed below.

1. Title page (page 1) consists of three sections. The first section contains the running head, the second contains the title, author’s name and institutional affiliation, and the third section contains the course code, instructor’s name and submission date.

- Section 1:
  - Running head—This is a shortened version of the title consisting of a maximum of 50 characters including spaces and punctuation. It must be flush with the left margin of the paper and be in all uppercase letters. The words “Running head” should be followed by a colon. The shortened version of the title should follow the colon.

- Section 2:
o Title— The title should concisely describe the central idea of the paper. It should be no more than 10 to 12 words in length, centered near the middle of the top half of the title page in headline style capitalization; that is, all important words should be capitalized, like a newspaper headline. Longer titles should be split between two lines.

o Author’s name— As you are the author, use your first name, middle initial, and last name. Leave out all titles and degrees. Centered in the top half of title page, under title.

o Institutional affiliation— Where the author or authors (students) are affiliated, for most students, this will be Hodges University. This should be centered in the top half of title page, under author’s name.

- Section 3:

  o Course Code— This is the series of letters and numbers identifying course, i.e. IDS 2001. Center this near the bottom of the title page, about 4 inches below the institutional affiliation.

  o Instructor’s name— This should be centered near the bottom of the title page, under the course code.

  o Date Submitted— State the date the assignment was turned in. The date must be centered near the bottom of the title page, under the instructor’s name. Include the full month, day, and year. Do not abbreviate the month, and leave suffixes (st, nd, th) off the day.

2. Table of Contents (page 2), if required.
3. **Abstract (next page after Title Page or Table of Contents).** It is a short summary of the entire paper in no more than 120 words. It must be:

- Blocked paragraph, first line NOT indented.
- Exact, only including information in the paper. Do not supplement or remark on the paper.
- Independent, all abbreviations and acronyms must be explained.
- Paraphrased, not quoted.
- Brief and precise---Strive for maximum information in each sentence, including most important ideas and results. Clear and comprehensible---Use active voice, action verbs, and present tense.

4. **Body of Paper (next page after Abstract)**

   Repeat the full title of the paper and center it on the first line of the page.

   - **Introduction**—This section states the exact problem or question or topic or concept being researched, and explains the research method, what was done and why?

   Consider the following:

   - Why is the problem important/significant?
   - How is the paper connected or relevant to the problem?
   - What is the value of this paper, and how does it relate to earlier studies?
   - What propositions are tested and how did the researcher arrive at them?

   - **Show the Development of the Problem**—For the most part, an all encompassing review is not required. Instead, provide a scholarly literature review to show history, context, and the research of others. Develop the problem sufficiently so that it may be understood by a professional audience.
• Communicate the Objective and Rationale for the paper—Describe the method used for resolving the question.

• Conclusion—Assess and expound upon what has been discussed throughout the paper.
  o Reiterate the problem or question or topic or concept and explain the research method. Answer the following in a few paragraphs to explain what was undertaken and for what reason:
    ▪ Why was this significant?
    ▪ How was this paper connected or relevant?
    ▪ What was the meaning or value of this paper, and how does it relate to earlier studies?
    ▪ What was being tested and how was it developed?

• References—There should be a reference list entry for each resource cited in the paper. Nothing should be listed in the references that is not cited in the paper.

Creating a title page. (Click here for a PowerPoint showing steps for formatting)

The title page (page 1) consists of: Running head, title, author’s name, institutional affiliation, course code, instructor’s name and date submitted (see previous section).

Instructions for formatting and creating a title page in Microsoft Word 2007

• Set the page margins, font, size and line spacing.
  o Open a new document.
  o Under the “Page Layout” tab, click “Margins” and choose “Normal.”
  o To select the font type and size go to the “Home” tab. Click the diagonal arrow next to the word “Font” in the Font section to access the full font menu.
- For “font:” select “Times New Roman.”
- For “font style:” leave it at “Regular.”
- For “size:” select “12.”
- Then click the “Default” button in the bottom left and say “Yes” when prompted to save these settings for future papers.
- Still on the “Home” tab, in the Paragraph section, click the “Line Spacing” icon. (4 lines with an up and down arrow, hover over icons to see more information about them.) Choose “2.0” (Double). If extra space seems to be inserted after you hit enter, go back to “Line Spacing” and choose “Line Spacing Options.” Make sure the boxes under “Spacing” next to “Before” and “After” both say 0 pt. (Hit enter once at the end of each paragraph.) You can also access this menu by clicking the diagonal arrow next to “Paragraph.”

- Inserting the page number and running head.
  - Double click near the very top of page to access the header. Under the “Design” tab, click the box next to “Different First Page.” Then under the “Header & Footer” section, click “Page Number” and then select “Top of Page” and “Plain Number 3” from the drop down menu. The number 1 should be in the top right corner of the page.
  - Directly in front of the page number, type “Running head:” followed by the running head for the paper. For example, “Running head: HODGES STYLE GUIDE” Hit the space bar enough times to move the running head completely flush to the left margin. (The page number should still be flush right.) Click in the body of the document underneath the dotted line to exit the header.
• Typing the title page
  
  o Section 1—title, student’s name, institution
    - Hit “Enter” about 8 times. Under the “Home” tab in the “Paragraph” section, click the “Center” text icon or “Ctrl + E.” (Hover over icons to see more information about them.) On separate lines, type the title of the paper using headline capitalization. Split the title into two lines if it is long. Type your first name, middle initial, last name in the next line. In line 3 of this section, type the name of the institution (Hodges University.)
  
  o Section 2—course, instructor, date.
    - Still centered, hit “Enter” about 8 times. Then type the course id, instructor’s name, and date submitted on separate lines.

Include the full month, day, and year. Do not abbreviate the month, and leave suffixes (st, nd, th) off the day (January 19, 2010). A sample title page is on the next page.

• Create a new page
  
  o Under the “Insert” tab, click “Page Break” or “Ctrl + Enter” to go to next page.
  
  o To set page header for the rest of the paper, double click in the top of the page to open the header. Insert the page number in the top right, then type the running head for your paper in all caps. (DO NOT type “Running head:”) Hit the space bar again to move the running head to the flush left. Click in the body of the document underneath the dotted line to exit the header.
Hodges University Style Guide

Susan L. Smith

Hodges University

IDS 2001

Dr. Susan Smith

January 4, 2010
Creating a table of contents. All papers five pages or longer are required to have a table of contents. It is easiest to create the table of contents last, after the paper has been written. It is often easier to create the table of contents in a new document and then insert or copy and paste it into the paper. The table of contents should include each heading and subheading in the paper along with the page number indicating where the section starts.

Instructions for creating a table of contents in Microsoft Windows 2007

- Open a new document.
- Center the heading “Table of Contents” on the first line. Hit “Enter.”
- Then “Align Text Left.” (Click the “Align Text Left” icon in the paragraph section or hit “Ctrl + L.”)
- Under the “Home” tab, access the “Paragraph” menu by clicking the diagonal arrow next to “Paragraph.”
  - Click the “Tabs” button on the bottom left.
    - In the “Tab Stop Position” box type “6”
    - Leave “Alignment” set to “Left”
    - Under “Leader” choose the “2” button (…..)
    - Click “Set”
    - Click “Okay”
- Once the tab is set, type the name of the first heading, then hit “Tab” and the ellipses (…..) will appear. Then enter the page number where that section starts.
- Indent the headings in the table of contents to show their level—level 1 no indent, level 2 indent ½ inch, level 3 indent 1 inch.
The table of contents for this guide is an example of how to format the table of contents for a paper in Hodges University Style.

**Headings.** Headings help to organize a paper. They are almost like an outline, with sections or areas of like significance being given the same level of heading. The Hodges University Style Guide uses three levels of headings:

Table 1.1 Format for Three Levels of Heading used at Hodges University

<table>
<thead>
<tr>
<th>Level of Heading</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Centered, Boldface, Uppercase and Lowercase Heading</td>
</tr>
<tr>
<td>2</td>
<td>Flush Left, Boldface, Uppercase and Lowercase Heading</td>
</tr>
<tr>
<td>3</td>
<td>Indented, boldface, lowercase paragraph heading ending with a period.</td>
</tr>
</tbody>
</table>

The headings in this guide use the appropriate levels and formatting. Note: APA differentiates between section titles and headings. Section titles include Table of Contents, Abstract, Title of Your Paper, References, Appendix/Appendices, and Footnotes. These section titles use regular font formatting and are centered, on their own line, and in headline case. As a general rule, a section starts on a new page.
Documentation

Using Hodges Style

Hodges Style is based on APA, which is used frequently by disciplines in the social sciences. There are two parts to documentation, in-text citations and the reference list. Remember for every in-text citation there must be a reference list entry, and no source should be listed on the reference list for which there is no in-text citation. Documentation is essential for establishing and maintaining credibility and avoiding plagiarism and academic dishonesty.

In-Text Citations

When to cite a source:

- Cite--ideas, theories, research, background information, support information, contradictory information, critical definitions, data
- All facts and figures that are not common knowledge must be cited in the text. If paraphrasing, quoting, or describing an idea, credit source.
- Note - there is no such thing as blanket citation. A citation at the end of a paragraph does not cover all sentences, ideas, facts, etc. in that paragraph.

All in-text citations have the following parts:

- Author’s surname. (Always refer to the author by his or her last name.)
  - If there is no named author, use the first few words of the title of the article. Use “Anonymous” as the author’s name only if the source lists it that way.
  - If you use the author’s name in the context of the sentence, you can omit it from the citation.
- Year of publication.
- Specific part of source like preface, introduction, etc.
• If visible, include the page numbers. If page numbers are not visible, as in the case of many online sources, use paragraph numbers.
  
  o For sources without page numbers, add the heading of the section and then the paragraph number. (Use only the abbreviation para. to indicate paragraph.)

**Common types of in-text citations.**

• Direct quotations—This is taking the exact words from a source. The words should be in double quotation marks followed by the citation which is inside the punctuation of the sentence.
  
  o Example: A study of college students found that “over half struggle with proper writing style and documenting sources” (Smith, 2009, p. 3).

• In a direct quote, some changes to a source need no explanation. It is acceptable to change the first letter of the first word of a quote to the opposite case. Likewise, the ending punctuation may also be changed to fit the structure of the sentence. Double quotations can be made into single and single into double.

• Changes that need explaining are:
  
  o Omitting material—Three spaced ellipses ( . . . ) indicate material omitted from source. If the omitted material is between two sentences, use four spaced ellipses.
  
  o Inserting material—Brackets are used to indicate anything inserted into the quotation by someone other than the author.
  
  o Adding emphasis—Italics can be used to show emphasis. Italicize a word or words you want to emphasize and follow with the words “emphasis added” in brackets.
Example: According to Downs (1994), “the cause of many of these diverse problems is attributed to unplanned and unrestrained [emphasis added] growth….attempts to tame unrestrained growth have themselves created problems” (p. VII).

- If there are citations in the source, leave them in the quote. Do not include them on the reference page unless they are cited as primary sources elsewhere in the paper.

- Paraphrasing or Summarizing—Paraphrasing is the restating of text or words in another form or using other words. Summarizing is presenting the main points in brief or concise form using other words. When paraphrasing or summarizing, an in-text citation is needed to credit the source.
  
  o Example: In a survey of college students, it was found that many have difficulty writing well and giving proper credit to sources (Smith, 2009, p. 3).

- Block Quotation—A direct quote containing 40 words or more should be formatted as a separate block of text and needs no quotation marks. A block quote always starts on a new line, and the entire quote should be indented ½ inch from the left margin. As the rest of the paper, block quotes should be double spaced. With block quotes, the citation information is placed outside the ending punctuation.
  
  o Example: Contrary to how it has been portrayed by the media, social capital is not a new concept:

  “Social capital” is to some extent merely new language for a very old debate in American intellectual circles. Community has warred incessantly with individualism for preeminence….Even Alexis de
Tocqueville, patron saint of American communitarians, acknowledged the uniquely democratic claim of individualism. (Putnam, 2000, p. 24)

More examples of in-text citations  Note – if the in-text citation appears at the end of a sentence, the period must be placed after the closed parenthesis.

- Work by one author:
  - (Weeks, 1943, p. 40).

- Work by two authors:
  - (Danes & Haberman, 2007, para. 1).

- Work by three, four, or five authors: Cite all authors the first time the citation appears in the text. In other citations, include only the first author followed by et al.
  - First citation: (Murphy, Quillinan & Carolan, 2009, p. 27).
  - Second and following citations: (Murphy, et al., 2009, p. 26).
    - Exception—if two or more citations shorten to the same form, use as many authors’ names as necessary to differentiate between the two sources followed by a comma and “et al.”

- Work by six or more authors—cite the first author followed by et al. for all citations.
  - All citations: (Smith, et al., 2009, p. 29)
    - Exception—if two or more citations shorten to the same form, use as many authors’ names as necessary to differentiate between the two sources followed by a comma and “et al.”

- Using “and” versus “&”
  - In the text of the paper, use “and” between the author’s names: According to Danes and Haberman (2007)…
In the in-text citation and on the reference list use “&” between names: (Danes & Haberman, 2007, para. 1)

Sources by authors with the same name—if there are sources with authors that have the same last name, use their first initials for all in-text citations although the year of publication may be different.

Example: Several studies were analyzed to determine the best method for this current study (G. Smith, 2009, p. 5, S. Smith, 2009, p. 32).

Work by a Corporate Author—include the full name of the corporate author and abbreviate in brackets for the first citation, abbreviate for all other citations.

First citation: (American Library Association [ALA], 2009, p. 27).

Second and following citations: (ALA, 2009, p. 6).

Work with No Author Listed—cite the first 2 or 3 words of the title followed by a comma. For periodical articles, chapters of books, and most web pages, use double quotes around the titles. For entire books, periodicals, brochures, reports and so forth, use italics for the titles.

(“Florida Unemployment,” 2009, p. 1)

Personal Communication—This source should be cited only in the text of the paper and not appear in the reference list. Personal communication includes but is not limited to: letters, memos, telephone conversations, personal interviews, e-mails, messages from listservs and electronic bulletin boards, and so on. List initials and last name of the author and an exact date as possible.

(S. Smith, personal communication, 2008).
- Electronic Sources—If there are no visible page numbers, use the paragraph number with the abbreviation “para.” in front. Find the heading of the section where information is found and include it in the citation. To determine the paragraph number in which the information appears, count paragraphs under that heading.
  - (Smith, 2009, Methodology, para. 4).
  - If the heading is long, it can be shortened but be in quotes (Smith, 2008, “What Librarians Think,” para. 2).
  - If there are no sections, just count paragraphs.
- Multiple works in the same in-text citation—If the works are by different authors, list the names in alphabetical order with a semicolon between each name.
  - Several studies agree with our findings (Johnson, 2004, p. 5; Jones & Thomas, 2003, p. 12; Smith, 2001, p. 23).
- Table—If a table is taken from a source, that source must be credited by listing the author and location information in a note at the bottom of the table.
- Secondary Source—This source should only be cited if the work is out of print, not in English, or not available through usual methods. Give the source from which the information was gathered (secondary source) in the reference list. In the text name the original source and give a citation for the secondary source.
  - If Smith is cited in Jones, but you did not read Smith, only Jones, list Jones in the in reference list and cite like this: Smith’s dissertation (as cited in Jones, 2009, p. 67).
Reference List

The publication and in some cases location information must be given for all sources cited in the paper. This information should be on a new numbered page at the end of the paper. The title of this page is References, but if the paper only cites one source, title the page Reference. The reference list is double spaced, and each entry should be formatted using hanging indents, that is, the first line of a text is aligned with the left-margin, and all other lines are indented (moved toward right) by one-half inch (5 to 7 spaces.) The simplest way to do this is to open the “Paragraph” menu in Word, and under “Indentation,” “Special,” choose “Hanging.”

Print Sources: Books

The reference list entry for a book includes:

- Author’s last name and first initial
- Year of publication
- Book title
- Place of publication and publisher. Always include both the city and the state.
  - Any other information such as edition number, report number, volume number, etc., should be in parentheses after the title.

For publishers, use a brief form of their name. Do write out all names of association, corporation, and university presses. Include in the name words such as “Book” or “Press” but not words like “Co.,” “Inc.,” or “Publisher.”

Book Examples

With one author.
Collins, J. C. (2001). *Good to great: Why some companies make the leap...and others don’t.*


**With multiple authors.**

Give the last names and initials for up to seven authors. (Johnson, E., Jones, D., Thompson, E. & Smith, G.) If there are eight or more authors, include the names of the first six, then ellipsis and the last author’s name. (Lewis, D., Brady, J., Wharton, R., Franz, G., Smith, S., Johnson, F.,…& Smith, J.)


**With no listed author or editor.**


**With a corporate author.** If the publisher is the same as the author, use “Author” in the place of publisher name at the end of the entry.


**Edited book without an author.**


Edited book with an author.


Multivolume work.


Part of a book: chapter, essay, article, foreword, preface, afterword in a book. Use the title of the chapter, essay or article after the year of publication. If foreword, preface, or afterword, say which one, i.e. “Preface.”


Government report.


Print Sources: Articles

The reference list entry for an article includes

- Author’s last name and first initial
- Date of publication
  - Remember to write the year then full month and/or date
- Article title
• Periodical title
• Volume number
• Issue number
• Inclusive page numbers
• DOI (digital object identifier) if there is one

Include the issue number if the periodical is paginated by issue. List the DOI (digital object identifier) if there is one. The DOI can often be found on the first page of the article. Use the full title of the periodical. Use p. or pp. with the page numbers only for entries for newspaper articles, but not for scholarly journals or trade and popular magazines.

Author Last Name, I. N. (Year, Month Day). Some article title: Some article subtitle. Any Periodical Title, volume number (issue number), inclusive page numbers.

doi:xx.xxxxxxxxxx

Article Examples

Article in a scholarly journal, with DOI.


Article in a scholarly journal, without DOI.


Magazine article.

Rubel, S. (2009, December 7). Gifts for those who have everything... in the cloud. Advertising Age, 80(41), 14.
Newspaper article.


- If the article is on consecutive pages, list the full range (C3-C5). If it is on non-consecutive pages, list all page numbers with commas in between (D1, D8).

Letter to the editor.


- Special sections, special issues, and editorials are handled the same way.

Other Sources Examples

Personal letter or other forms of personal communication. References should be cited only in the text of the paper and not appear in the reference list. Personal communication includes but is not limited to: letters, memos, telephone conversations, personal interviews, e-mails, messages from listservs and electronic bulletin boards, and so on. List initials and last name of the author and an exact date as possible.

- (S. Smith, personal communication, 2008).

Audiovisual Source Examples

Put the primary contributor(s) in the first position, where the author’s name would go. In parentheses, list how they contributed. Treat episodes of television or radio series like book chapters, with the script writer and director where the author would be, and the producer where the editor would be.
Motion picture.
Producer Last Name, I. N. (Producer), & Director Last Name, I.N. (Director). (Year). *Title of some motion picture or television show* [Format, i.e. television broadcast, television series, motion picture]. Country of Origin: Studio

Television broadcast.

Television series.

Film.

Music recording.
Writer, I. N. (Copyright year). Title of song. [Recorded by I. N. Artist if different from writer.] On *Title of some album* [Medium of recording: CD, record, cassette, etc.] Location: Label. (Date of recording if different from copyright date)

Music recording example.

- Include the side and band or track number in the in-text citation: “Wild Horses” (Jagger & Richards, 1971, track 1).
Software. Reference list entries are not required for standard software and programming languages such as Microsoft Office, Java, Adobe products, or even SPSS. Reference them in the text with the full name and version information. Reference entries are needed for specialized software or programs with limited availability.

Rightsholder Last Name, I. N. (Year). Title of program (Version number) [Description of form: computer program, language, software, etc]. Location: Name of producer.

or

Rightsholder Last Name, I. N. (Year). Title of program (Version number) [Description of form: computer program, language, software, etc.]. Retrieved from http://xxx

- Names of software, programs, or languages are not italicized.
- If the rights are owned by an individual, name them as author, otherwise, treat as any other unauthored work.

Electronic Sources: Sources Accessed Online

Reference list entries for electronic sources should have the same components in the same arrangement as a physical or print source with as much information about locating the source as needed so others can also find it. If there is a DOI (digital object identifier) listed, it should always be part of the reference and is the only locator information needed. A DOI can often be found on the first page of the article, or in a database results page. If there is no DOI, list the site where the electronic book was retrieved or the home page of the periodical or journal, or in the case of a website, the home page of the site.
Electronic version of a print book, with DOI.


Electronic version of a print book, without DOI.


Journal article retrieved online, with DOI.


Journal article retrieved online, without DOI.


Document from a web site.


Document from a web site, no author, no date.


- “n.d.” stands for “no date.”
E-mail.
As with all personal communication, e-mail should only be cited in the text of the paper and not appear in the reference list.

Abstract.

Associations with intimate relationships, psychopathy and Machiavellianism [Abstract].


Newspaper article online.
Appendix

Sample Paper
Leadership: A Theoretical Approach

Nancey Wyant
Hodges University

IDS 2001
Dr. Smith
January 21, 2010
Table of Contents

Abstract .......................................................................................................................... 3
Definitions of Leadership .............................................................................................. 5
  Transactional Leadership ......................................................................................... 7
  Transformational Leadership .................................................................................. 7
Summary ...................................................................................................................... 8
References .................................................................................................................... 10

All papers five pages or longer are required to have a table of contents. The table of contents should include each heading and subheading in the paper along with the page number indicating where the section starts.
Leadership has been a topic of discussion for many years, but systematic study of leadership did not begin until well into the twentieth century. The focus of this research has been determining leadership effectiveness by attempting to discover what traits, abilities, behaviors, types of power, or situational aspects effect how a leader is able to lead. This paper will look at these various theories of leadership addressed by researchers in an attempt to better understand what makes a good or effective leader.
Leadership has been a topic of human concern for hundreds, perhaps thousands, of years. It has excited interest among scholars and laypeople alike. It has probably been the subject of debate since the first two people came together for the purpose of completing a task. The term symbolizes images of powerful, dynamic, exciting men and women whose exploits and deeds formed the basis of many legends and myths throughout time and history. From the days of the famous Egyptian ruler, Cleopatra, to those of the infamous German dictator, Adolph Hitler, the subject of leadership has been something of an enigma. While some leaders have been credited with important world events, others have been ridiculed and blamed. According to Yukl (2002), “The widespread fascination with leadership may be because it is such a mysterious process, as well as one that touches everyone’s life” (p. 1).

Questions about leadership have long been a subject of speculation, but the systematic study of leadership did not begin until the 1930s. Since that time, leadership has been one of the most frequently studied phenomena in the social sciences (“Leadership,” 1999, p. 490). The focus of much of the research has been on the determinants of leadership effectiveness as researchers have attempted to “discover what traits, abilities, behaviors, sources of power, or aspects of the situation determine how well a leader is able to influence followers and accomplish group objectives” (Yukl, 2002, p. 2). The reasons why some people emerge as leaders and the determinants of the way a leader acts are other important questions that have been researched, but the paramount concern, however, has been “leadership effectiveness” (Yukl, 2002, p. 2). Bass (1990) reviewed more than 3,000 studies on leadership and claimed the precise nature of leadership and its relationship to key criterion variables such as subordinate satisfaction, commitment, and performance is still uncertain. According to Bass (1990),
Nothing is supposed to be as practical as a good theory, but nothing seems more impractical than a bad one; a theory may be good for one purpose and bad for another, for theory is supposed to be a way of trying to understand the facts. Unfortunately, leadership theories sometimes obscure the facts. Much effort then has to be expended in coping with obscurity. (p. 37)

Some progress has been made in probing the mysteries surrounding leadership, but many questions remain unanswered. Obviously, there is a lot of ground to cover.

Definitions of Leadership

Researchers seem to disagree on the definition of leadership. Most of the disagreement stems from the fact that leadership is a complex phenomenon involving the leader, the followers, the situation, and the goals or objectives that are to be obtained. Some leadership researchers have focused on the personality, physical traits, or behaviors of the leader while others have studied how aspects of the situation affect the leader’s behavior. Some have even suggested that there is no such thing as leadership—the situation may have a much greater impact on whether the organization succeeds or fails than does any individual, including the leader (Meindl & Erlich, 1987). Thus, leadership researchers have defined leadership in many different ways:

- Leadership is “the behavior of an individual . . . directing the activities of a group toward a shared goal” (Hemphill & Coons, 1957, p. 57).
- “Leadership is exercised when persons . . . mobilize . . . institutional, political, psychological, and other resources to arouse, engage, and satisfy the motives of followers” (Burns, 1978, p. 18).
- Leadership is “the process of influencing the activities of an organized group toward goal achievement” (Rauch & Behling, 1984, p. 46).
Leadership “is the ability to step outside the culture . . . to start evolutionary change processes that are more adaptive” (Schein, 1992, p. 2).

Leadership is “the ability of an individual to influence, motivate, and enable others to contribute toward the effectiveness and success of the organization . . .” (House et al., 1999, p. 184).

Stogdill (1974) concluded that “there are almost as many definitions of leadership as there are persons who have attempted to define the concept” (p. 259). Although there are many and varied definitions of leadership, most reflect the assumption that it involves a process whereby a person intentionally influences others to voluntarily behave in such a way as to accomplish a goal or an objective and directs the organization in a way to make it more efficient and effective. Thus, three important points to consider are (1) leadership is a social influence process, and in order for it to occur, there must be a leader and a follower; (2) the action or behavior performed by the follower is voluntary as opposed to behavior that is performed due to formal authority or coercion; and (3) the result of leadership is follower behavior that is objective- or goal-oriented in an organizational environment. In simple terms, it is a process of influencing others toward achieving group goals.

Although there are differences and disagreement among researchers about the identification of leaders and leadership processes, much of the literature does indicate, however, that leadership has always been considered a prerequisite for organizational success. “Because no one yet has been able to demonstrate through research or logical argument that leadership ability is a handicap to a manager, we can state that all managers should ideally be leaders” (Robbins, 1994, p. 495). Nadler and Tushman (1990) provide further support by stating, “Given
issues such as the increased capability afforded by enhanced communication technology and the rise of international business, leadership is more important now than ever before” (p. 77).

**Transactional Leadership**

Transactional leadership occurs when leaders and followers are in some type of exchange relationship which satisfies needs for one or both parties. The exchange could be economic, political, or psychological in nature; and examples might include exchanging money for work, votes for political favors, and loyalty for consideration. Transactional leaders help organizations achieve their current objectives more efficiently by linking job performance to valued rewards or by ensuring that employees have the needed resources to get the job done (Avolio & Bass, 1988). Transactional leadership is very common but tends to be transitory in that there may be no enduring purpose to hold parties together once a transaction is made. Burns (1978) noted that while this type of leadership could be quite effective, it did not result in organizational or societal change and, instead, tended to perpetuate and legitimize the status quo. Thus, transactional leaders view management as a series of transactions in which they use their legitimate, reward, and coercive powers to give commands and exchange rewards for services rendered.

**Transformational Leadership**

The transformational process is currently the most popular leadership perspective (McShane & Von Glinow, 2005), and it moves beyond the more traditional transactional approach to leadership. Transformational leadership is related to charisma in that these leaders motivate people to transcend their personal interests for the sake of the larger community (Bass, 1985). It also produces levels of subordinate effort and performance that go beyond what would occur with a transactional approach alone (Robbins, 1994). Moreover, transformational leadership is more than charisma. While the purely charismatic leader may want followers to
adopt his or her world view and go no further, the transactional leader “will attempt to instill in followers the ability to question not only established views but eventually those established by the leader” (Avolio & Bass, 1990, p. 23).

According to Bennis and Nanus (1985) four skills are required in order for the transformational leader to be successful—(1) a strategic vision or a goal that elicits people’s attention; (2) an ability to successfully communicate that vision through words, manner, or symbolism; (3) the capacity to build trust by being consistent, dependable, and persistent; and (4) the capability of positive self-regard by striving for success (p. 27). The use of these skills builds follower commitment and energizes them to adopt the leader’s vision as their own. They also perform their jobs better, engage in more organizational citizenship behaviors, and make better or more creative decisions (McShane & VonGlinow, 2005). Thus, transformational leadership “is closer to the prototype of leadership that people have in mind when they describe their ideal leader and is more likely to provide a role model with which subordinates want to identify” (Bass, 1990, p. 54).

Summary

It is clear that leadership is a complicated phenomenon that is the subject of much debate and research over time. Perhaps “the importance of leadership is best expressed by Napoleon who quipped he would rather have an army of rabbits lead by a lion than an army of lions lead by a rabbit” (Bass, 1990, p. 6). There is evidence that the emergence and continued success of a leader is a complex function of his or her characteristics, the characteristics of his or her followers, and the characteristics of the situation. Some of the more important personal qualities of a leader seem to be high intelligence, need for power, energy level, charisma, and concern for his or her followers. Some autocratic leaders make all the decisions for their followers, whereas
others take a supportive approach, working actively with followers to ensure that all group members have a chance to contribute to a task. According to the transactional model of leadership, the effectiveness of these different behaviors and decision styles is contingent on attributes of the followers and of the situation.

As a discipline, leadership faces new challenges. Leaders of the future will continue to face the obstacles of significantly changing organizations and environments. Some of these changes include the transformation of the American economy from one based upon industrialization to one based upon knowledge and the challenge of other economies—in particular, the Chinese and the others of the Pacific Rim. The accelerating trend toward positioning organizations to be more competitive in a global environment will be a primary contributor to the need for organizational leadership in the future. Another challenge is the new role of leaders, managers, and management itself as more women, Hispanics, African Americans, other minorities, and workers with different expectations enter the workforce.

Future leaders who think intelligently and creatively, empower and treat employees as their organizations’ most important resources, and adapt to the changing conditions of an increasingly fluid environment will ensure their survival and success. As a result, the issue of leadership will no doubt receive more attention from researchers. It is certain that more research is needed to develop insights about how to be a successful leader.
References


The publication and in some cases location information must be given for all sources cited in the paper. This information should be on a new numbered page at the end of the paper. The reference list is double spaced, and each entry should be formatted using hanging indents, that is, the first line of a text is aligned with the left-margin, and all other lines are indented (moved toward right) by one-half inch (5 to 7 spaces.)